
Revision 2.0 

          PaperClip32 

 

Quick StartQuick Start  
GuideGuide 



PaperClip32 Quick Start ii 

Copyright Information 

© Copyright 2003, PaperClip Software, Inc. The PaperClip32 product name and PaperClip Logo 
are registered trademarks of PaperClip Software, Inc. All brand and product names are registered 
trademarks of their respective corporations. 

 



PaperClip32 Quick Start III 

Contents 
 
Quick Start – Introduction........................................................................................................4 
Administrative Tasks ................................................................................................................5 

Add a Workstation, a User Account, and a Bin .......................................................................5 
Add a Workstation ...............................................................................................................5 
Add a User Account .............................................................................................................7 
Add a Bin ...........................................................................................................................11 

Add Document Types............................................................................................................14 
Add a SoftClip Document Type..........................................................................................14 
Add a PaperClip32 Image Document Type........................................................................17 

Add a Drawer and Folder ......................................................................................................20 
Add a Drawer .....................................................................................................................21 
Add a Folder ......................................................................................................................22 

Create a Query......................................................................................................................24 
Using PaperClip32 ..................................................................................................................28 

Open a Folder .......................................................................................................................28 
Use Quick Folder to Find a Folder.........................................................................................29 
Scan Documents into PaperClip32 .......................................................................................30 

Scan a Single Document ...................................................................................................30 
Scan a Batch .....................................................................................................................32 

Index a Batch ........................................................................................................................34 
Assemble the Document for Indexing ................................................................................34 
Index the Document after Assembly ..................................................................................34 

Import an Imaged Document .................................................................................................37 
Working with SoftClip Documents .........................................................................................38 

Creating and Adding a SoftClip Document ........................................................................38 
If Never Store SoftClips to Bins, was Selected............................................................................. 39 
If Always Store SoftClips to Bins, was Selected........................................................................... 39 
If Prompt to Store SoftClips to Bins, was Selected....................................................................... 40 

Import a SoftClip Document ...............................................................................................40 
Execute a Saved Query ........................................................................................................41 
Route a Document ................................................................................................................42 



PaperClip32 Quick Start 4 

Quick Start Quick Start –– Introduction Introduction  

This Quick Start guide, intended for the system administrator and a typical user, provides 
exercises for setting up a system and using PaperClip32 to perform typical document management 
tasks. This includes: 

Administrative Tasks  Using PaperClip32 

• Add a Workstation 

• Add a User Account 

• Add a Bin 

• Add Document Types 

• Add a Drawer and Folder 

• Create a Query 

• Open a Folder 

• Scan Documents into PaperClip32 

• Index a Batch 

• Import an Image Document 

• Working with SoftClip Documents 

• Use Quick Folder 

• Execute a Saved Query 

• Route a Document 

On your PaperClip32 CD in the \Docs\Pclip32 directory you will find detailed instructions on all 
PaperClip32 administrative and user tasks in the manual titled PaperClip32UserGuide.PDF. 

Note: If you are the system administrator, refer to the Introduction and System Setup & 
Administration sections in the PaperClip32 User Guide for detailed instructions. 

After completing the exercises in this guide, you may delete the objects (drawers, folders, 
documents, etc.) you create 

A Note About Clipping 

There are two ways to integrate PaperClip32 with the application or applications you use 
to operate your business. One is with our API and the other is with our Visual Context 
ProcessorTM (VCP). This guide has a number of references to the VCP but we use the 
terms “Clipping” or “Clipped to.” This is the concept that PaperClip’s VCP “Clips” 
PaperClip32 to another application. 

If your business applications or applications have been “Clipped to” PaperClip32, you 
would be able to select a record in your application and press the user-defined VCP hot 
key such as Ctrl F3 and the PaperClip32 folder for that record would appear displaying 
all imaged and SoftClip files (files created in an application such as Word or Excel). If 
there isn’t folder for that record, PaperClip32 would ask if you want to create one. It 
would do that by extracting the necessary information from the “Clipped” application.  
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Administrative TasksAdministrative Tasks  

Add a Workstation, a User Account, and a Bin 

Workstations should be set up before user accounts are created. Workstation configurations are 
specific to individual workstations on the network. If the workstation will be used with a scanner, 
the scanner interface must first be defined. 

The user account identifies your employees by name and password (optional) for the system login. 
User accounts also define user privileges, determining which PaperClip32 tasks employees can 
perform, and on which objects (batch, drawer, folder, document, note, overlay, package, and 
query) they may perform the tasks. 

PaperClip32 users can store documents in different on-line or near-line storage bins according to 
the document type they wish to store. Documents requiring frequent retrieval may be stored on-
line, while documents that are retrieved less frequently may be stored near-line. 

Add a Workstation 

1. Choose Workstations from the Setup menu. The Workstations dialog box appears. In 
this example, it shows the Manager workstation. This is the default workstation name 
assigned to the first client. If other workstations were installed on your system before 
this exercise, they also would be listed. 

 

2. Click Add. The Add Workstation dialog box appears with the General tab controls 
displayed. 
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3. In the Name: box, type the computer name assigned to the workstation. 

 

4. If this isn’t a scan station, leave the Scanner Type: list box at the default setting of 
(None). If this is a scan station, use the drop-down list to select the appropriate 
scanner type. 

Note: The ISIS Scanner selection is for existing systems that were upgraded from version 
5.0. Do not select ISIS for new installs. 

5. The Temp Directory: is a local directory location for temporary file storage during 
scanning, faxing, and image retrieval. No entry is required and should not be changed 
for this exercise 

6. Use the Toolbar Button Size: list box to set the size of the toolbar buttons that 
display in PaperClip32. 

7. Select the Production Mode: check box to enable Production Mode capability for 
this workstation. See the Production Mode section in the Customizing Your System 
chapter of the PaperClip32 User Guide. 

Note: Production Mode must be enabled in the user account record (see the next section 
“Add a User Account”) for this setting to be enabled. 
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8. Click OK to save the workstation configuration. Then click Close to close the 
Workstations dialog box and return to the main PaperClip32 desktop. 

Add a User Account 

In order for your employees to access and use PaperClip32, they must be assigned an 
individual user account. At the time your system was purchased, one or more of the Full 
Production, Desktop Workstation, and Viewer user profiles were selected. User profiles are 
described below: 

Full Production This type of user can create, modify and delete documents if given 
the appropriate rights. Also, the user can view, print, fax, e-mail 
and annotate documents and send packages to other users. This 
user profile is required for scan stations. 

Desktop Workstation This type of user can modify and delete documents if given the 
appropriate rights. Also, the user can view, print, fax, e-mail and 
annotate documents and send packages to other users. 

Viewer This type user can view, print, fax, and e-mail documents. 

Admin This user type is intended for the system administrator. The Admin 
user has the same rights as a Viewer user and the additional rights 
to perform setup operations. 

Note:  The system administrator can use this user account for 
all setup operations. 

Inactive This user type disables the user login. 

The user account also enables you to set up a personal drawer and to change the default hot-
key assignments for the employee. 

1. Select User Accounts from the Setup menu. The User Accounts dialog box appears 
with the accounts defined in the system displayed. At this time, it may just be the 
MANAGER account. 
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2. Click Add. The Add User Account dialog box appears with the General tab displayed. 

 

3. Enter the users login name. When a user launches PaperClip32, the network login 
name will appear in the Login Name box. If you want to use the network login name 
as the user’s login, enter that name in the Name: box and the user’s full name (up to 
30 characters.) in the Full Name: box. 

4. In the Password: box, you may type a password for the user (password not required). 
As you type the password, PaperClip32 displays asterisks (*) for each character. 

5. Select the user’s profile in the Profile: box. 

6. Choose the Desktop tab to configure the user’s desktop. 
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7. In Toolbar Preferences, select your preferences for displaying the toolbar and the 
toolbar button size. 

8. In Other Preferences, select your preferences for displaying the status bar, displaying 
the annotation tools, and enabling Production Mode. Selecting Enable Production 
Mode activates the settings in the Production Mode group box with additional options 
for Production Mode processing. 

9. If you have checked Enable Production Mode, to automatically arrange an 
application on the desktop whenever the employee logs on, check Auto Arrange 
Application. When you do, the drop-down Application list becomes active. 

Note: Application must be an application Clipped to and the application must already be 
open when you launch PaperClip32. 

10. Check Auto Open First Document in Folder to automatically open the first scanned 
document in a folder when the folder is opened. 

11. In the Maximum Open group box, set the maximum number of folders and documents 
that can be open at one time. This is not required. No entry means that the user can 
open any number of folders and documents at one time. 

12. Choose the Drawers tab. Here you can select a personal drawer or drawers to display 
in the Open Folder selection window. If you do not select a personal drawer or 
drawers, all the drawers available to you will be displayed when you are in the Open 
Folder selection window. 

 

13. Select the Privileges tab to set the privileges. 
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14. If the user you are defining is a Full Production user, select your preferences in the 
Supervisor, Global Access Rights, and Executive check box. Checking Supervisor 
gives this user rights to system setup functions and automatically assigns all privileges 
in the Privileges table. 

You can assign Global Access Rights, whether or not they are a supervisor. This 
enables the employee to access all drawers, folders, and documents, regardless of their 
ownership. You need to consider security issues and access to confidential documents 
when you assign supervisory privileges and global access rights. The combination of 
user privileges and task group membership determines how your employees may use 
PaperClip32 features and functions. 

15. To grant a user privileges to all the objects their user profile allows, click on All 
privileges to all objects. To grant selected privileges, select an Object: then the 
Privileges: allowed. 

16. Select the Hotkeys tab if you want to modify the default hotkeys. You would typically 
change a hotkey if another application on the workstation uses the same hotkey as 
PaperClip32. This is not required for this exercise. 
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17. Click OK to save the user account record. Then click Close to close the User 

Accounts dialog box and return to the main PaperClip32 desktop. 

Add a Bin 

You can store documents in different on-line or near-line storage bins. Documents requiring 
frequent retrieval may be stored on-line, while documents that are retrieved less frequently 
may be stored near-line. 

An on-line bin is a directory on the local or network hard drive. Typically on-line media 
provides faster access but less storage capacity as compared to near-line media. Near-line bins 
are used to store documents to different locations on a fixed or removable DOS drive (e.g., 
magnetic, magneto-optical, or removable media storage drives). Near-line bins may also be 
defined as one of many PaperClip Network Object Storage Subsystem (NOSS) servers. 

This exercise demonstrates the steps to add an on-line bin. 

Note:  A default on-line bin is established at installation. The initial storage location for this 
bin is DEFBIN. The DOS directory that is to be established as a bin must be created 
before beginning this procedure. Multiple storage bins cannot share the same 
directory. 

1.  Select Bins from the Setup menu. The Bins dialog box appears. 
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2.  Choose Add. The Add Bin dialog box appears with the General tab controls 
displayed. 

 

3.  Enter a name for this on-line bin and select Online. 

4.  Click the Location tab and type the directory location for the on-line bin you are 
creating. Optionally choose Browse to specify an appropriate directory location. 
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5.  To write files to a subdirectory tree, enter the desired number next to # of 
Subdirectories. Writing files to subdirectories provides better file system performance 
for very large bins. You can change this value if desired with no harm to the system. 
You can also set a value for existing Bins. In this case all previously written files will 
remain where they are, only newly created files will go into subdirectories. 

6.  Choose OK to save this on-line bin location information and return to the Bins dialog 
box. 

7.  Click Close to return to the PaperClip32 desktop. 
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Add Document Types  

Now that you’ve set up a workstation and a user account, you will need to set up Document 
Types. Document Types are essentially how you specify to the PaperClip32 system the different 
types of documents that you will be working with, such as memos, invoices, bills of lading, 
personnel records, and more. PaperClip32 supports SoftClip Application Document Types, 
documents created in an application such as Word or Excel, and PaperClip32 Image Document 
Types, the scanned images created with a workstation scanner. The file type associated with the 
application, the .doc file with a word processing application or .pci for a PaperClip32 image file, 
is the basis for the document types that you specify. You can specify multiple document types for 
any one file type. 

In this exercise, you will define a document type named Client Letter and associate it with the 
Microsoft Word .doc file type. You will also define a PaperClip32 Image Document Type named 
Invoice and associate it with the PaperClip32 Image Document .pci file type. 

Add a SoftClip Document Type 

Documents, sound files, pictures, movies, etc. you create with another application can be 
stored as SoftClip documents in any folder. Any true 32-bit Windows compatible application 
qualifies as a SoftClip application. Creating this link is automatic with PaperClip32. 

PaperClip32 automatically detects any application installed on the server or the workstation, 
and registered in the Windows Registry. The file types associated with those registered 
applications are also detected and integrated within your PaperClip32 system. 

You can add a SoftClip application to your PaperClip32 system simply by installing it to the 
server or workstation. The associated file type is also included. 

More than one document type can be assigned to each SoftClip application. For example, 
word-processing documents can be grouped into smaller categories, such as purchase orders, 
invoices, and client letters. SoftClip documents should be stored in a network directory so that 
multiple users may access them. 

For this exercise we are adding a new SoftClip Document Type where the file type is a 
Microsoft Word .doc file. 

1.  Select Document Types from the Setup drop-down menu. The Document Types 
dialog box appears. 
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2. Choose Add. The Add Document Type dialog box appears with the General tab 
controls displayed. 

 

3.  Enter a name and description. In this exercise, the name is Client Letters, and this 
document is a record of official company letters sent to clients. The documents with 
this document type can be restricted to a drawer. If you check Restrict to drawer, 
select a drawer, and click on the left arrow. 

4.  Select the File Type tab. Open the drop-down list then locate and select Microsoft 
Word Document. The Extension: text box displays the file extension of the selected 
file type. 
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5.  Click on the Access tab and select Open in the Default Action area. This will launch 
Word when you select a Word document to view. 

 

6.  Click on the Storage tab 
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7.  You can select the default location as Online or Nearline and the appropriate Online or 
Nearline bin. No need to change these values for this exercise. 

8.  Click on the Security tab. 

 

9.  In the Ownership area, select an owner for this Document Type by clicking on the 
Owner: button and selecting an owner from the owner selection window. Check Set 
owner to document: to specify the owner selected as the owner of any document 
created with this Document Type. The radio buttons in the Document owner section 
are active when this box is checked. 

When the As default selection radio button is selected, the owner will be 
automatically selected in the owner field when creating a document. The user can 
change the selection if desired before creating the document. 

When the Forced upon creation radio button is selected, the owner will be 
automatically selected as the owner of the document. The user will not be able to 
change the owner field when this Document Type is specified. To change the owner 
during document creation, you would select another Document Type that does not 
have this restriction. 

10.  Click on OK to save this Document Type. 

Add a PaperClip32 Image Document Type 

1.  To add an Image Document Type, click on the Add button in the Document Types 
dialog box. The Add Document Type dialog box appears with the General tab 
displayed. 
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2.  Enter the name Invoice and a description. 

3.  Select the File Type tab. The default file type that displays in the File Type: window is 
PaperClip32 Image Document. The extension text box displays the file extension of 
the selected file type, pci in this case. 

 

4.  No changes are required on the Access tab. 

5.  Click on the Storage tab 
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6.  You can select the default location as Online or Nearline and the appropriate Online or 
Nearline bin. No need to change these values for this exercise. 

7.  Click on the Security tab. 

 

8.  In the Ownership area, select an owner for this Document Type by clicking on the 
Owner: button and selecting an owner from the owner selection window. Check Set 
owner to document: to specify the owner selected as the owner of any document 
created with this Document Type. The radio buttons in the Document owner section 
are active when this box is checked. 

When the As default selection radio button is selected, the owner will be 
automatically selected in the owner field when creating a document. The user can 
change the selection if desired before creating the document. 

When the Forced upon creation radio button is selected, the owner will be 
automatically selected as the owner for the document. The user will not be able to 
change the owner field when this Document Type is specified. To change the owner 
during document creation, you would select another Document Type that does not 
have this restriction. 

9.  When you finish, click on OK then Close to return to the PaperClip32 window. 
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Add a Drawer and Folder 

This exercise demonstrates how to add and set up a drawer. A drawer record, as shown below, is 
the General information, Folder Index, Folder Data, and Document Data that are stored for each 
drawer. 

  

  

 

The following describes the information in a drawer record. 

Name The file drawer name. 

Description A brief, but meaningful, description that describes the function of the drawer 
to others. 

Owner The owner of the drawer. 

Internet Secure Indicates that the specified drawer is secure from access via the Internet 
using the PaperClip WebServer module. Note that the default setting for the 
Internet Secure: selection box is checked. If you are using WebServer and 
a browser to view documents and you want this drawer to be accessible by 
Internet users, uncheck this box. 
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Folder Index 
Fields 

Folder index fields are defined when adding a file drawer. Later, when 
folders are added to the drawer, values for these fields may be entered 
manually or extracted automatically by the Visual Context Processor for 
drawers that have been clipped to an application. 

You may define up to ten folder index fields, with a maximum total of 100 
characters. At least one index field is required to define a drawer. 

Folder Data 
Fields 

These are user-defined fields that further identify folders. These fields are not 
used for indexing, but aid in searching. A total of ten folder data fields may 
be defined. 

Document Data 
Fields 

These fields help identify each document within a folder and provide the 
ability to search for specific groups of documents. Each document is labeled 
with at least three document data fields: document type, document 
description (optional), create date, and number of pages. Up to ten custom 
document data fields can be defined. 

Add a Drawer 

1. Select Drawers from the Setup menu. The Drawer dialog box appears. 

2. Choose Add. The Add Drawer dialog box appears with the General tab controls 
shown. 

 

3. Type a name for your file drawer and a brief description. 

4. Select an owner for the drawer. 

5. Click the Folder Index tab and choose Add. This displays the Add Folder Index Field 
dialog box. 
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6. Type in the name of an index field, select a type, and in the Settings area enter a 
Length: and optional data field Mask:. For this exercise, enter First Name for Name:, 
select Character, a length of 15, and no Mask. Press OK and the Add Drawer dialog 
box displays, with the Folder Index tab showing the new index field. Add two 
additional index fields with the following attributes: Last Name – Character – 15 – no 
Mask and SSN – Character – 11 – ###-##-####. 

7.  The Folder Data and Document Data dialog boxes are accessed in the same manner 
but you can skip these for this exercise. 

8.  Click OK to create the drawer and return to the Drawers dialog box. 

9.  Click Close to return to the PaperClip32 desktop. 

Add a Folder 

There are two ways to add folders. You may add folders directly by clicking the Add button 
in the Open Folder dialog box shown below. 

 

With this method, you enter the appropriate field values for each folder index field. You may 
also add folders automatically from within another application program by pressing the Visual 
Context Processor (VCP) hot key if your application has been Clipped to PaperClip32. For 
this exercise, we will add a folder using the Add button. 
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1.  To add a Folder, select Open Folder from the File drop-down menu. The Open 
Folder dialog box appears. 

2.  Select the drawer you created. Note that the folders list box is empty and the message 
line at the bottom of the dialog box reads "0 Folders found." 

3.  Click Add. The Add Folder dialog box appears. 

 

4.  Enter a description for this folder. 

5. To restrict access to this document, select an owner by pressing the Owner button and 
selecting an owner from the list in the Owner Selection dialog box. If you do not 
change the ownership, the document will inherit the ownership of the folder in which it 
is created. 

6. Select an owner and choose OK to save the new owner name and continue processing 
or choose Cancel to return to the Add Folder dialog box without specifying a new 
owner. 

7. Complete the folder index fields with values of your choosing. 

8. Choose OK. The Open Folder dialog box reappears with the new folder in the 
Folders: list box. 

9. Choose Close to accept the data and return to the desktop. 
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Create a Query 

Queries are created using the New Query dialog box. This dialog box contains control tabs to 
define the Query search criteria and function buttons for executing or saving your Queries. 

1. To create a new Query, do one of the following: 

• Press the New Query toolbar button . 

• From the File pull down menu, choose New Query. 

• Press Cntl Q. 

The New Query dialog box appears. 

 

Use the General tab to specify the name, type, and scope of the Query. The Query tab is where 
you actually build the expressions used in your Queries and combines those expressions into more 
complex statements. The Destination tab is used to specify a destination for the Query results, as 
well as to define which batch operations, if any, to perform on those results. Finally, you use the 
Layout tab to layout the physical order of the fields within your Queries, to define the sort 
position of each field, as well as the order in which to sort the data within fields that appear in the 
columns in the Query Results window. 

2. On the General tab type a name for the Query. This can be a long descriptive name up 
to 100 characters in length. 

3. Select an owner for this Query. 

4. In the Type group box you can select either Document or Folder, select Document. 

5. In the Scope group box you can specify the scope of the Query you are creating, All 
drawers or a (Select a drawer), select All drawers. 
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6. Select the Query tab to build your query. 

 

7. In the Expression Builder group box tree control, select the Drawer, Folder, or 
Document field for which you want to create an expression and select the Build 
button. In this exercise, click on the expander button for Document, highlight 
Description, and select the Build button. 

8. The Text Query on Document Description dialog box opens. 

9. Select Prompt on Execution as shown below. 

 

10. This selection will result in a prompt for a document description when the Query is 
executed. 
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11. Select the Destination tab. You would select Window if you want the results of this 
query are to be displayed on the screen in the Query results window, or select Batch 
operations if you want an operation or operations specified in the Batch Operations 
group box (grayed out until you select Batch operations) to be executed on the 
documents or folders found as a result of the query. For this exercise, select Window. 

 

12. Select the Layout tab. 
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13. Click on the expander button for Drawer, highlight Description, and select the Add 
button. Do the same for Folder and Document. Your results will look like the 
following diagram. 

 

14. Select Save to save your Query. 
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Using PaperClip32Using PaperClip32  

Open a Folder 

If your business application or applications were Clipped to PaperClip32, you would press your 
user defined VCP hot key to open a folder (see the note about Clipping on page 4). In this 
exercise, you will open a folder from the main PaperClip32 desktop. 

 

1. Select Open Folder from the File drop-down menu or press Ctrl O. 

2. The Open Folder dialog box will appear. 

 

3. Select the desired drawer and folder then select Open. The selected folder appears. 
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Use Quick Folder to Find a Folder 

Any time the Open Folder dialog box is open, the Quick Folder feature is automatically available 
for use. This feature lets you quickly find a specific folder, show a list of all existing folders, or 
quickly add a new folder to a drawer. Quick Folder is activated as soon as you type any 
characters when the focus is on the Folder List box. The Quick Folder dialog box appears with 
the characters you typed shown in the first folder index field. In order to select a specific existing 
folder, you must fill in all the required folder index fields exactly. If you want to retrieve a list of 
folders matching the characters you entered, type as many characters of the folder indices as you 
know. If you are adding a folder, select Create Folder If New to have PaperClip create a new 
folder with the specified index fields. 

Once all the required fields are filled in, choose OK and one of the following actions will occur: 

• If a folder exists matching the characters you entered, the folder is selected and the folder 
window displays a listing of all the documents in that folder. 

• If there are two or more folders matching the characters you entered, they appear in the 
Folder List box. 

• If the folder does not exist and Create Folder If New is selected, the system creates the 
new folder. 

• If no folder(s) matching the characters you entered can be found and Create Folder if 
New is not selected, the systems prompts you to re-enter proper index information and 
returns you to the Quick Folder dialog box. 
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Scan Documents into PaperClip32 

Imaged documents may be added to a folder in one of three ways; scanned, imported, or drag and 
dropped. 

Scan a Single Document 

3. Select Open Folder from the File drop-down menu. 

4. The Open Folder dialog box will appear. 

 

3.  Select the drawer and folder into which you want to scan a document then select 
Open. The selected folder appears. 

4.  To scan a document, select New from the Document menu, press Ctrl N, or click on 
the New Document icon. The New Document dialog box appears. 

 

5.  To restrict access to this document, select an owner by pressing the Owner button and 
selecting an owner from the list in the Owner Selection dialog box. If you do not 
change the ownership, the document will inherit the ownership of the folder in which it 
is created. 
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Note: The default PaperClip32 owner is called Use Parent. The icon is a parent holding a 

child’s hand . If you assign this ownership to the document, the document will 
inherit the same ownership as the folder in which the document is contained. If the 
ownership of the folder changes, the ownership of the document will change. 

6.  Select the appropriate document type from the drop-down list box. In this exercise, 
select the document type, Invoice, defined in the Administrative Tasks section of this 
document. If you have not defined this client type, select any PaperClip32 Image 
Document document type. 

Note: Users with Supervisor privilege will see the Add Document Type button  to the 
right of the document type drop-down list box. You would select this button to 
define a new document type. 

7.  Enter an optional description to further identify the document. This will help to 
identify the document in the folder window, and in the title bar of the viewer window. 

Note: It is highly recommended that you enter a description for all imaged documents. 
The description helps you identify the document later. 

8. Click on OK. 

9. PaperClip32 displays the Scan dialog box, prompting you, "Select scanning option." 

 

10. Place your page on the scanner bed, or place the page(s) in the automatic feed tray, 
and click on the Scan button. If you prefer to review the scanned pages after they are 
scanned, click on the Scan and Review button instead. If your scanner is not 
configured, you must click on the Configure button before you start the scan. For 
further information, see Scanner Configuration in the PaperClip32 User Guide. 
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11. If your scanner has an automatic document feed, PaperClip32 displays the 
PaperClip32 document scanner window while it scans. You may click on the Cancel 
button to abort the scan at any time it is in progress. 

12. With a flatbed scanner, the message displays: "Please open scanner flatbed and place 
document face down. Press <OK> to continue." Click on the OK button. PaperClip32 
displays the PaperClip32 document scanner window while it scans. Click on the 
Cancel button to abort the scan in progress. 

13. If you are using a flatbed scanner, when prompted to "Scan another page?", insert the 
next page and click on the Yes button, or click on the No button to stop scanning and 
store the document (or to review before storing, if that is the option you chose). 

14. Once the document has been stored, PaperClip32 displays the new document at the 
top of the folder window’s list of documents. Documents are sorted in date order, 
with the most recently created document at the top of the folder. 

Scan a Batch 

Image pages may be scanned into an interim type of storage, called a batch. Batched images 
are held in the Batch List until assembled into documents and filed into folders (indexed) at a 
later time. 

1.  Select New, Batch from the File menu or select the Batch icon  from the tool bar. 

2.  PaperClip32 displays the Scan dialog box, prompting you, "Select scanning option." 

3.  Place your page on the scanner bed, or place the page(s) in the automatic feed tray, 
and click on the Scan button If you prefer to review the scanned pages after they are 
scanned, click on the Scan and Review button instead. If your scanner is not 
configured, you must click on the Configure button before you start the scan. For 
further information, see Scanner Configuration in the PaperClip32 User Guide. 

4.  If your scanner has an automatic document feed, PaperClip32 displays the 
PaperClip32 document scanner window while it scans. You may click on the Cancel 
button to abort the scan at any time it is in progress. 

5.  With a flatbed scanner, the message displays: "Please open scanner flatbed and place 
document face down. Press <OK> to continue." Click on the OK button. PaperClip32 
displays the PaperClip32 document scanner window while it scans. Click on the 
Cancel button to abort the scan in progress. 

6.  If you are using a flatbed scanner, when prompted to "Scan another page?", insert the 
next page and click on the Yes button, or click on the No button to stop scanning and 
store the document (or to review before storing, if that is the option you chose). 

7.  To review the scanned batch at this point, click on Yes. PaperClip32 displays the 
Review Scanned Batch dialog box. If you want to view the batch at a later time, click 
on No. The Scan Batch dialog box will appear. 

8.  You can tag the batch with optional Note and Batch ID fields. PaperClip32 does not 
need these fields to reference the batch; it uses date and time fields. These optional 
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tags may be useful to you later to identify one of several batches from a log of scanned 
batches. 

9.  Enter an optional Note (up to 40 characters) to append to this batch. 

10.  Enter an optional eight-character Batch ID for this batch. (Example: InsDocs) 

11.  Click on the OK button to store the batch. 

12.  If you have Routing privileges, the Route Batch dialog box opens. 

 

You can select from the following options 

Yes This indicates that you want to Route this batch. This dialog box will 
appear for each subsequent batch. Once you click on Yes, the New 
Package dialog box will appear. 

Yes to 
All 

This indicates that you want to Route all of the batches you scan. This 
dialog box will not appear again until you start a new session. Once you 
click on Yes to All the New Package dialog box will appear. 

No This indicates that you do not want to Route this batch. This dialog box 
will appear for each subsequent batch you scan. 

No to All This indicates that you do not want to Route any batches that you scan. 
The dialog box will not appear again until you start a new session. 
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Index a Batch 

After a batch has been scanned or imported, it may be indexed. Batch indexing requires two steps. 
First, the pages within the batch are assembled into one or more documents. Second, the new 
documents are assigned to folders. 

Assemble the Document for Indexing 

1. Select Batch List from the File menu or select the Batch List icon  on the tool 
bar. The Batch List window appears displaying the list of batches to be indexed. 

2. Select the batch to be indexed. 

3. Click Index. The Batch: window will appear, displaying the first image in the selected 
batch. (If necessary, maximize the Batch: window to view all options.) 

4. The image can be manipulated using any of the image manipulation features on the 
tool bar or by placing your cursor on the document displayed, pressing the right mouse 
button and selecting an image manipulation feature. 

5. Select a page number in the Batch box to inspect a particular page of the batch. 

6. If you decide that the page in the viewer belongs in the document you are currently 

assembling, click on the add button . (If you wish to assign all pages in this 

batch to the document, click on the all button .) 

Index the Document after Assembly 

1. Click on the Create Document button when you have selected all the pages that 
belong in the document you wish to create. 
 
When you click on Create Document and you have not already selected a folder, 
either by Clipping (see note below) or by pressing the Select Folder button in the 
Batch window, the Select Folder for Batch Indexing Documents dialog box is 
displayed. Select the destination drawer. Select the destination folder by double-
clicking on it or by highlighting it and clicking Select. To create a new folder for the 
document, click on the Add button, enter the necessary data, click on OK, and select 
the new folder when it appears on the list. 

Note: When the Batch: window is open and you hot key from a Clipped application, the 
clipped folder becomes the selected one for indexing. The folder does not open on 
your desktop. 

2. If you have already selected a folder by either clicking on the Select Folder button or 
hot keying from a Clipped application and you now click on the Create Document 
button, the Folder Selection Options dialog box appears. This dialog box allows you 
to control the folder to be used and the appearance of the Folder Selection Options 
dialog box. The following describes the Folder Selection Options dialog box button 
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selections, and the consequences of selecting each button for the indicated dialog box. 
A check indicates that the dialog box will be displayed 

Yes This indicates that you want to use the currently selected folder to store 
this document. This dialog box will appear for each subsequent 
document, unless the batch is closed and reopened or another option is 
selected. Once you click on Yes, the New Document dialog box will 
appear. 

Yes to 
All 

This indicates that you want to use the currently selected folder to store 
all the documents in the batch. This dialog box will not appear again, 
unless the batch is closed and reopened. Once you click on Yes to All 
the New Document dialog box will appear. 

No This indicates that you want to select a new folder in which to store this 
document. This dialog box will appear for each subsequent batch unless 
the batch is closed and reopened or another option is selected. Once 
you click on No, the Folder Selection dialog box will appear followed 
by the New Document dialog box. 

No to All This indicates that you want to select the folder for each document. The 
dialog box will not appear again, unless the batch is closed and 
reopened. The Folder Selection dialog box will always appear before 
the New Document dialog box. 

3. Once a folder has been selected, the New Document dialog box will appear. 

4. Enter an owner, type, and description. 
 
The New Document dialog box will remember the last document type used, and will 
position the Type: drop-down list selection on that document type when the list 
appears. For example, if you are indexing a group of invoices and you select Invoice as 
the document type, the next time the New Document dialog box appears the document 
type will default to Invoice. This will only happen for the current session of 
PaperClip32. 

5. Click on OK. PaperClip32 creates a document from the selected pages and places it in 
the folder. 

6. Once a document has been indexed, the Page Deletion Options dialog box appears. 
This dialog box allows you to control two things: deletion of indexed pages and the 
appearance of the Page Deletion Options dialog box. 

7. Select a page deletion option: 

Yes This indicates that you want to delete the pages after this document is 
indexed. This dialog box will appear for each subsequent document, 
unless the batch is closed and reopened or another option is selected. 

Yes to All This indicates that you want to delete the pages each time a document 
is indexed. This dialog box will not appear again, unless the batch is 
closed and reopened 
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No This indicates that you do not want to delete the pages after this 
document is indexed. This dialog box will appear for each subsequent 
batch unless the batch is closed and reopened or another option is 
selected. 

No to All This indicates that you do not want to delete the pages after any 
documents are indexed. The dialog box will not appear again, unless 
the batch is closed and reopened. 

8. The Assemble Document window reappears. Repeat this procedure until there are no 
more pages in the batch. 

9. When there are no more pages to be indexed, click on the X button in the top right of 
the window to close the batch-indexing window. 

 



 

PaperClip32 Quick Start 37 

Import an Imaged Document 

To import an imaged document to PaperClip32, do the following. 

1. Open the appropriate folder from the Open Folder dialog box. 

2. Select Import from the Document menu. The New Document dialog box will appear. 

3. To assign ownership to this document, select an owner from the drop-down list. 

4. Select a PaperClip32 Image Document type. 

5. Enter an optional description for the document. 

6. Click on the OK button. The Import File(s) dialog box will appear. 

 

7. Use the dialog box to find the correct drive, directory and file. When the correct image 
file(s) appear in the File Name: field, click on the Open button. 

8. To select multiple image files to be part of the same imaged document, click on the left 
mouse button at each image file, while holding down the Ctrl key. 

9. PaperClip32 imports the file(s) and updates the folder window to include the new 
document. 

Note: Importing can also be accomplished via the File/Import menu section or via drag 
and drop from Explorer. 
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Working with SoftClip Documents 

SoftClip documents can be added to a folder in three ways; selecting New Document, imported, 
or drag and dropped. 

Creating and Adding a SoftClip Document 

You can create and add a SoftClip document to the folder using the New Document 
command on the File menu. 

1. Open the appropriate folder from the Open Folder dialog box. The folder window will 
appear. 

2. Select New from the Document menu, or click on the New Document icon. The New 
Document dialog box will appear. 

3. To restrict access to this document, select an owner from the drop-down list. 

4. Select the appropriate SoftClip document type. In this exercise, select the document 
type, Client Letters, defined in the Administrative Tasks section of this document. If 
you have not defined this client type, select any Word document type. 

 

5. Enter an optional description for the document. This helps to identify the document in 
the folder window. 

6. Click on the OK button. 

Note: The remaining steps are dependent upon the setting of the SoftClip File Options in 
the System Parameters record. 

Your system was set up to store SoftClip files by one of the following three methods. 
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Never Store SoftClips 
to Bins 

The user assigns the name and storage location for each 
document. PaperClip32 stores the document in the selected 
folder. Any changes made to the document, independently of 
PaperClip32, will be reflected when the document is retrieved 
through PaperClip32. 

Always Store SoftClip 
to Bins 

PaperClip32 automatically names and stores the file in the 
appropriate storage bin. Any changes made to the document, 
independently of PaperClip32, will not be reflected when the 
document is retrieved through PaperClip32. 

Note: When Always Store SoftClip to Bins is selected no 
additional dialog box will appear. 

Prompt Allows the user to select the SoftClip storage option for each 
document, individually. 

 

For further information, refer to Setup System Parameters in the PaperClip32 User Guide. 

If Never Store SoftClips to Bins, was Selected 

1. PaperClip32 displays the Choose File Name for New SoftClip Document dialog box: 

 

2. Type in the File Name and click on Save. 

3. PaperClip32 launches the application and displays a new document. 

4. Create the new document, save it and exit from the application to return to the 
PaperClip32 folder window. 

5. The updated folder window will appear, with the new SoftClip document at the top. 

If Always Store SoftClips to Bins, was Selected 

1. PaperClip32 launches the SoftClip application and displays a new document. 

2. Create the new document. 
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3. Save the file and exit from your application without changing the file name. 
PaperClip32 saves the file automatically assigning its own file name (e.g., 48.DOC). 
PaperClip32 displays the updated folder window, with the new SoftClip document at 
the top. 

If Prompt to Store SoftClips to Bins, was Selected 

1. PaperClip32 displays the following message: 

 

• Click on Yes to have PaperClip32 name and store the file in the default bin. 

• Click on No to select a directory. 

Import a SoftClip Document 

If you select the Import command, PaperClip32 will allow you to bring a pre-existing software 
file into the folder. 

Note: Before you import a SoftClip document, a document type must be defined for the 
desired software. 

1.  Open the appropriate folder from the New Folder dialog box. The folder window will 
appear. 

2.  Select Import from the Document menu. The New Document dialog box will appear. 

3.  To assign ownership to this document, select the owner from the drop-down list. 

4.  Select the appropriate SoftClip document type. 

5.  Enter a description for the document. This helps identify the document in the folder 
window. 

6.  Click on the OK button. 

Note: Importing can also be accomplished via the File/Import menu section or via drag 
and drop from Explorer. 
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Execute a Saved Query 

You can execute a Query that you see in the Query List window. Before the Query is run, the 
system checks that you have the proper user privileges to run it. 

1. Choose Query List from the File pull down menu. The Query List window appears 
showing you any existing queries to which you may have access. 

2. If you want to execute an existing Query, select it in the Query List window and 
choose Execute from the Query pull down menu or, optionally, use the right mouse 
button to select Execute from the pop-up menu. The system executes the Query using 
the saved search criteria and displays the results or, if the destination selected is Batch 
Operations, those operations will be executed. 
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Route a Document 

You can route any PaperClip32 document to a user’s InBox. 

1. Open the folder from which you wish to route a document. 

2. Select the document. 

 

3. Select Route from the Document menu. The Package (New) dialog box displays. 

 

4. Leave the priority for this routed package as the default of High. 
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5. Enter the optional title, which identifies a routed package in the recipient’s InBox. 

6. Click the Address command button. The Select Recipients dialog displays. 

 

7. Select a recipient from the Available list, and then click the left arrow icon. The name 
moves to the Selected: list. 

8. Click OK. The Package (New) dialog displays. The name you selected appears in the 
address list. 

9. Click the right mouse button while your cursor is in the Package (New) dialog box and 
select Send in the drop-down menu. 

10. Check with the recipient to verify they received the package. 


